
Instructions for Use of Maple in Mathematics 251

The computer programMaple is a powerful tool which can help you solve a wide range of mathe-
matical problems: it can differentiate, integrate, and otherwise manipulate mathematical formulas, perform
arithmetic calculations, plot curves and surfaces in two and three dimensions, solve differential equations,
and carry out a variety of other useful mathematical operations. At Rutgers, Maple is available on the student
computereden. The current version of Maple isMaple7, which was released in the summer of 2001. It was
scheduled to be installed throughout the student labs by the beginning of the Fall 2001 semester. Descriptions
of projects will be given for Maple7, but the projects have been tested on several versions, so should run on
whatever version is available. On all systems, there is both atext basedandgraphical interface version.
The graphical version will be used here. On Unix systems, like eden, this graphical version is calledxmaple,
since it is customized to run under the X windows system. Maple is also available on the Windows PCs and
Macintoshes in the public labs. Although the commands you use to do mathematics with Maple will be the
same on all these machines, there are differences among computers, such as in the way that files are opened,
saved, and printed.

First login to youredenaccount. If you get anxtermwindow with aunix prompt, you can start up
Maple by typingxmaple & (note that “xmaple” is in lower case; typing the & allows you to continue using
your xterm window for other purposes while Maple is running). A Maple window will open and you can
begin typing Maple commands at the Maple prompt.

In some cases, after you login, you may get a set of menus, rather than aunix prompt. In this case, first
typeu (for userinfo). At the next menu, typer (for revert). Hit the ENTER key when asked, and at the
next two menus, typeq for quit . Click on the box to logout and then login again. You should now get the
unix prompt.

Getting started: From an x-terminal in one of the public labs (e.g., in ARC) you should log in toeden, then
start Maple by typing the commandxmaple & (note that “xmaple” is in lower case; typing the & allows
you to continue using your xterm window for other purposes while Maple is running). A Maple window
will open. At the top of the Maple window is theMenu Bar, consisting of a row ofmenu buttons(File, Edit
etc.). Underneath the row of menu buttons is theTool Bar, most of which are shortcuts to menu commands.
Directly below theTool Bar is theContext Bar, which consists of more buttons which are shortcuts to menu
commands. If you have enabledBalloon Help from the Help Menu, when you place the mouse pointer on
any of these buttons, a rough idea of what the button does will appear. Finally, below theContext Baris a
window with the labelUntitled (1). You can now give an instruction to Maple by placing the mouse pointer
in this window (just to the right of the prompt>), typing a Maple command, and then typing a carriage
return. Maple carries out the command and prints a response. For example, if you type1 + 1; , Maple
will respond with2. Note that each Maple command ends with a semicolon. (If you forget the semicolon,
Maple will remind you.) If you select part of the worksheet, the right mouse button brings up aContext
menu that can be useful in editing the worksheet.

Getting Help:. Since you will not be given a Maple manual, you should learn to use Maple by using the
built in Help facility. One way to get help on a particular topic, such as theplot command, type, after
the prompt>, the command?plot (a semicolon is not used when asking for help). A window will open
describing the basic structure of the command and giving examples of its use. To close this window when
you have finished with it, click the left mouse button on the rectangle in the upper left corner of the window
and then drag the mouse pointer down, releasing the button whenClose is highlighted. You don’t need
to close the help window when you want to return to your worksheet: you can select parts of your Maple
session with the mouse or theWindow menu. If you have asked for a lot of help, this menu has an item
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called “Close All Help” that can tidy things up. The graphical interface allows another way to invokeHelp,
which is to place the mouse pointer on the wordHelp at the far right of the Menu Bar, click the left mouse
button, and drag the mouse pointer down, releasing the button when the desired item (such asTopic Search)
is highlighted. We shall refer to this process aschoosingTopic Search from theHelp menu. Fill in the
Topic box, click the left mouse button on the item that you want, and then click onOK . This method works
well if you want to expand your knowledge of a particular Maple command, but may not help locate the
command that implements a particular action. For this type of help, aFull Text Searchmay be most useful.
The lab projects in this course aim to introduce and illustrate relevant features of Maple before asking you
to obtain new results, so theTopic Searchis likely to be the most immediately helpful. Other forms of help
become useful when exploring features not used in this course.

To continue, you will need to know some basic commands and syntax of Maple.

Arithmetic: The operations addition, subtraction, multiplication, division, and exponentiation are indicated
by +, -, *, /, ˆ respectively. Fractions are represented exactly, and Maple automatically simplified
them. Thus, if you type1/3+1/6; , Maple will answer 1/2.

All grouping of expressions is done with the left and right parentheses ( and ). Although the usual
rules of precedence apply, parentheses can always be used to clarify your intent. Variables are not restricted
to single letter names, as in Elementary Algebra (and most Calculus textbooks). You can use (almost) any
string of letters and numbers that starts with a letter. As a result, the productxy must be writtenx*y , not
xy or x y ; if you typexy , Maple assumes you are referring to a variable called “xy ”. Thus, to enter the
expression(2x + y2)/(2x + ex)+ 1 into Maple, you type:

(2*x +yˆ2)/(2*x + exp(x)) + 1;

Recent versions of Maple allow you to use apalette(available from theView menu) to help build expressions.
Projects for this course use a “seed file” containing formulas given in the description with space for you to
add new formulas as you work through the project. You can add more space using theExecution Group
item of theInsert menu or the button on the toolbar that looks like the [> Maple prompt.

Note that the exponential function is built into Maple and is referred to asexp . The numbere, if you
ever need it, isexp(1) . The numberπ has the special namePi — not pi which looks the same, but is a
variable. If you want to, you can saypi:=3; but this won’t affect the value ofπ or anything that depends
on it. However, Maple will fuss at you if you try to change the value ofPi . Maple also recognizes names
like log , sin , cos , tan as standard functions. Those names are also protected against use as names of
variables.

When operating on integers or fractions, Maple does exact arithmetic, rather than using decimal ap-
proximations. To get a decimal approximation, use the Maple commandevalf . The Maple command
evalf(4/7); produces a 10 digit approximation to 4/7—as will typing4.0/7.0; . Additional accu-
racy can be obtained by including a second argument: typingevalf(4/7,20); will produce a 20 digit
approximation. You can change also precision for your whole Maple session by setting a new value to the
reserved variableDigits .

Algebra: To help you do algebraic manipulations, Maple has the commandsexpand , factor , and
simplify , which you can learn about by using theHelp facility. It is often necessary toexpand and
expression before Maple will know what it means tosimplify it.

Algebraic numbers like the square root of 2 are considered exact quantities. If you enter

a:=(sqrt(2)+1)ˆ10; ,
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Maple will appear to simply echo aprettyprint version of that statement. To get an answer in the form
3363+2378*sqrt(2), you need to follow this with

expand(a); .
You can also solve algebraic equations by using the commandssolve (for exact answers) orfsolve

(for numerical answers to the accuracy specified byDigits ).

User-defined Functions and Expressions:In Maple,xˆ2 - 2*x +3 is anexpression. You can assign
a name to this expression for future use by typingg:= xˆ2 - 2*x +3; . Note that a colon is required
before the equal sign in an assignment statement. Expressions can contain several variables, as inh:=
y*t - sin(y) . To evaluate an expression at a particular value, use the Maple commandsubs . For
example,subs(x=2,g); will produce the value 3. (Maple also has a construct called afunction, defined
by statements likef:=x -> xˆ2 - 2*x +3; . We won’t often use these, since it is easier to work with
expressions, but you might see them in examples onHelp screens.)

Plots: The basic plotting command in Maple isplot . This command has many forms—for example,
several functions can be plotted at once—so you should look carefully at the examples given at the end of
its Help page to get some idea of its flexibility. There are many other plotting commands in Maple; in this
course we will use primarilyplot3d andimplicitplot . To use some of the plotting commands you
must first issue the commandwith(plots); . For example, this is necessary in order to use the command
implicitplot . It is frequently useful to enlarge the size of a plot. To do this, place the mouse pointer
in the region occupied by the plot and click the left mouse button. This places a box around the plot and
changes the Menu Bar and Control Bar (and context menu) so that new options are offered to manipulate
the plot. The plot is resized by placing the mouse pointer at one of the small dots along the edge of the
box and dragging the pointer. When you have finished modifying the plot, move the mouse down to the
next prompt> and click the left mouse button. When viewing three dimensional plots, it is useful to view
the plot from different viewpoints. First, place a box around the plot by moving the mouse pointer in the
region occupied by the plot and clicking the left mouse button. Now, place the mouse pointer inside the box
and while holding down the left mouse button, move the mouse pointer to different positions. Explore the
effects of using theAxesand other commands on theMenu Bar. (In the current version, you see changes
immediately, but earlier versions required you to selectRedraw from a menu in order to see your changes.)

Vectors: As of Maple6, Maple now has two different packages for linear algebra. These packages allow
powerful operations to be introduced simple by calling them by name, but they impose a complicated structure
on everything they touch. As a result, simple things become more difficult. In this course, we are mostly
concerned with vectors as triples of numbers, and the operations that we need have been described simple
using that notation. Maple includes a structure called alist that is easy to use and has all the properties that
we need. You describe a list by enclosing a sequence of quantities separated by commas in square brackets.
Thus,[1, 3, -1] describes a point, and[cos(t),sin(t),t] describes ahelix. The description of a
space curve like a helix can be directly differentiated with respect to its parameter as a step in using Calculus
to find properties of the curve.

Differentiation and Integration: In addition to performing basic calculations and evaluating standard func-
tions, Maple can also differentiate and integrate. Thediff command differentiates expressions. For exam-
ple,diff(x*sin(x), x); differentiatesx sin(x)with respect tox. If you have named an expression, it
is a useful convention to introduce a modification of that name as a name for the derivative (or partial deriva-
tives). A second derivative can be found quickly by differentiating the first derivative using the name that you
introduced. If you need a second derivative without seeing the first derivative, eitherdiff(x*sin(x),
x, x); ordiff(x*sin(x),x$2); may be used. If you have typedg:=xˆ2*y; , thendiff(g,x);
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is the first partial derivative ofx2y with respect tox anddiff(g,x,y); is the mixed second partial deriva-
tive.

Note that Maple assumes that everything not involving the variable with which it is differentiating is
constant. This means that no special notation is required to distinguish partial derivatives of expressions
from ordinary derivatives. Although we claim to be differentiating functions in Calculus, the techniques are
based on examining how variables appear in expressions, so the way that Maple works with expressions is
more familiar.

The command for both definite and indefinite integration isint . If Maple cannot evaluate a definite
integral exactly, numerical integration may be used. Type?int and?int[numerical] for details on
integration in Maple. Definite integrals are evaluated using a single instruction: it is not necessary to apply
thesubs instruction to the result of indefinite integration.

Maple Worksheets: The window which appears when you start Maple is called aMaple worksheet. To
complete each computer assignment in Mathematics 251 you are asked to turn in aneditedprintout of your
work; such a printout can be obtained by editing, and then printing, your worksheet. The printout should
include only the numerical, symbolic, and graphical output of Maple which is appropriate for the solution
of the problems assigned, plus text material interpreting the results obtained by Maple. Using theT tool
will change a line of the worksheet to text mode, allowing descriptive material to be added. This can also be
used to label graphical output, but better results can be obtained using thetitle option in the plot instruction.
Maple includes various editing capabilities which should enable you to produce neat and coherent output,
and which we now describe.

To remove an unwanted portion of your Maple worksheet (e.g., a region containing commands that you
typed incorrectly or that were not directly relevant to the solution of the exercises), select the region to be
deleted by clicking the left mouse button at the beginning, then dragging the mouse across to the end of the
portion of the worksheet you wish to delete. The region should now be highlighted. TheDeletekey will
purge what you have selected. A safer approach is to chooseCut from theEdit menu or toolbar. This allows
you to copy the removed region to a new location, select the region as above by selectingPastefrom the
Edit menu or toolbar. There is also aCopy item in theEdit menu. that makes a region available for pasting
without removing it from the worksheet. These operations are borrowed from your computer’sWindow
Manager, so it should be possible to copy parts of your Maple worksheet to other applications. However,
this may not work as smoothly as it does with applications that are more closely integrated with the system.

To insert text, such as a label for a plot, into your worksheet, click the mouse at the beginning or end
of the plot and chooseText Input from the Insert menu. Now type your label. To continue using your
worksheet, move the mouse pointer down to the next prompt> and click the left mouse button. If there is
no prompt, insert one by clicking on the prompt symbol> in the Tool Bar Menu.

Sometimes it is useful to be able to place a comment after a Maple command, rather than insert text
elsewhere in the worksheet. To do this, enter the sharp symbol #. Everything typed on a line following this
symbol will be considered by Maple to be a comment, and therefore not executed.

To make your worksheet less cluttered, it is a good idea to have Maple suppress the output of various
commands, e.g., the commandwith(plots) or a command given to assign a name to a plot. To do this,
end the command with a colon (:), instead of a semicolon (;).

Printing your Maple Worksheet: To print your Maple worksheet, choosePrint from theFile menu or
click on the print button in theTool Bar (its position varies, but it is with the other file tools at the left and
it looks like a printer). A panel will appear with the options “Output to File” and “Print Command” at the
top. Clicking on “Print Command” will direct your output to the printer if the command has been correctly
entered, while clicking on “Output to File” places your output in a file, whose name is given in the adjacent
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box (the default isuntitled.ps). If you wish to change the file name or the print command, click in the box and
type your changes. Since the file will be a postscript file, the file name should have the formsomething.ps.
When you have finished making your choices, click on the “Print” button.

Saving your Maple Worksheet: If your work is interrupted, you can save your work so that you can later
resume where you left off. To save your Maple worksheet, chooseSave Asfrom theFile menu. Then type
the name of the file in which you wish to save your worksheet in theSelectionbox where the mouse pointer
is (replacing the asterisk). The file name should have the formsomething.mws. After you have typed the
filename, click on “OK” to save the file. Once you have named the worksheet and saved it in a file, you
can save further changes by choosingSavefrom theFile menu. Maple automatically keeps track of the
filename. If you wish to close one of your open worksheets, make it active by clicking in it, and then select
Closefrom theFile menu. Maple will prompt you to save the worksheet if you have changed it since the
last save.

Opening a Previously Saved Worksheet:To open a previously saved worksheet, chooseOpen from the
File Menu. Click on the name of the file you wish to open and then click onOK . Although you will see
the output from your previous work,noneof the definitions made there are currently active. You will need
to selectExecute Worksheetfrom the Edit menu or hit theEnter key on individual lines to restore your
previous state. By contrast,everythingyou did in the current session on different worksheets is remembered.
Therestart; command can be used to cause Maple to clear previous definitions and revert to its initial
state.

Ending your Maple Session: To end your Maple session, chooseExit from theFile menu. A box will
open, reminding you that all unsaved work will be discarded. If you have saved what you need or wish to
exit anyway, click on “Exit.”

Obtaining Copies of the Labs in Worksheet Form: In some of the labs, part of the lab will ask you to
execute a string of Maple commands to learn what they do. To avoid retyping these commands, you can first
obtain a modified copy of the lab in worksheet form (a “seed file”). This modified copy will omit instructions
and problems and contain only strings of some of the Maple commands you are asked to execute. Once you
obtain this file, you can access it by following the instructions in the sectionOpening a Previously Saved
Worksheet: To save typing, outlines of the commands described in the labs have been saved in “seed files”.
These can be obtained from the course page using your internet browser. When you have saved the file in
your home directory, you can load it into a Maple session from theFile:Open menu.

Useful Commands and Techniques:If Maple gets hung up in a calculation or is taking too long, click the
mouse on thestopbutton in theTool Bar menu.

Any Maple command previously entered in your worksheet can be re-executed without retyping it in a
new location. Simply move the mouse to the position of the command you wish to execute and hit theEnter
(or Return) key.

It is often useful to be able to refer later to the result of a computation—the output of some command—in
a simple way. To make this possible, simply assign the output of the command to a variable. For example, if
you entera:= evalf(2*Pi); then you can later square the result ofevalf(2*Pi); by typinga*a; .
It you find that you need a recent result that was not named, the special names%, %%, etc. may be used to
refer to the previous result, the one before that, etc. (the instructions are not clear about how much of the
history can be retrieved in this way). A better solution might be to add a name the line that computed the
expression and re-execute that line.

You can assign a name to a plot just as described above for assigning a name to an expression. Several
previously named plots can then be displayed on the same graph by using the commanddisplay . Type
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?plots[display] for details.
Only the most recent assignment to a name is remembered. You can unassigna by typinga:=’a’; .

To clear all the assigned variables in a Maple session, you can typerestart; as indicated earlier. If you
are unsure of what value has been assigned to the namea, you can typea; at the current prompt. Such
working notes should be edited out of the worksheet before you submit it.

Getting Help From Other Students:
The purpose of the Maple assignments is partly to learn about Maple, a very useful program for symbolic,

numerical, and graphical computations, and partly to help you understand the material in the course. Just as
with other homework assignments, it is permissible and helpful to discuss the Maple labs with other students.
However, the Maple labs you are turning in are being graded and will be part of your final course grade,
and the printed form of the worksheet is expected to be the work of the student who submits it. The grader
will concentrate on the text comments that interpret the results of the computation, and these are expected
to reflect yourindividual understanding of the topic.
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